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Access Fundamentals 

Microsoft Access is a powerful database program you 
can use to store all kinds of information—from a 
simple list of contacts to an inventory catalog with tens 
of thousands of products. Once information is stored in 
a Microsoft Access database, it’s easy to find, analyze, 
and print. 

This chapter is an introduction to working with Access. 
We don’t get into great depth here, but we make sure 
you understand the key parts of Access, such as tables, 
forms, queries, and reports. You’ll learn about the main 
components of the program screen, how to work with 
database objects, and how to use help. 

Objectives 

Introduction to Databases 

Understand the Screen 

Open and Save a Database 

Work with Database Objects 

Tour of Tables 

Tour of Queries 

Tour of Forms 

Tour of Reports 

Help 

Close and Exit Access 
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Introduction to Databases 

In its simplest form, a database is a collection of information organized into a list. Whenever you make a list 
of information, such as names, addresses, products, or invoices, you are, in fact, creating a database.  
Technically speaking, you don’t even have to use a database program to create a database. You can make a 
list of information in all kinds of programs, such as Microsoft Excel or Word. 

A database program, however, is much more powerful than a simple list you keep on paper or in a Microsoft 
Word document. A database program lets you: 

• Store Information: A database stores lists of information that are 
related to a particular subject or purpose. A database stores 
personal information, such as a list of Aunt Mildred’s home recipes, 
or business information, such as a list of hundreds of thousands of 
customers. A database also makes it easy to add, update, organize, 
and delete information. 

• Find Information: You can easily and instantly locate information 
stored in a database. For example, you can find all the customers 
with the last name “Johnson” or all the customers who live in the 
55417 ZIP code and are older than 65. 

• Analyze and Print Information: You can perform calculations on 
information in a database. For example, you could calculate what 
percent of your total sales comes from the state of Texas. You can 
also present information in a professional-looking printed report. 

• Manage Information: Databases make it easy to work with and 
manage huge amounts of information. For example, with a few 
keystrokes you can change the area code for hundreds of 
customers in the (612) area code to a new (817) area code. 

• Share Information: Most database programs (including Microsoft 
Access) allow more than one user to view and work with the same 
information at once. Such databases are called multi-user databases. 
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Database Objects 

Databases usually consist of several parts. A Microsoft Access database may contain up to seven different 
database object types. Some objects you will use all the time (such as Tables), while others you may hardly 
ever use (such as Modules). 

 

Database Objects 

 Tables Tables store a database’s data in rows (records) and columns (fields). For 
example, one table could store a list of customers and their addresses while 
another table could store the customers’ orders. A database must always 
contain at least one table where it can store information—all the other database 
objects are optional. 

 Queries Queries ask a question of data stored in a table. For example, a query might only 
display customers who are from Texas. 

 Forms Forms are custom screens that provide an easy way to enter and view data in a 
table or query. 

 Reports Reports present data from a table or query in a printed format. 

 Macros  Macros help you perform routine tasks by automating them into a single 
command. For example, you could create a macro that automatically opens and 
prints a report. 

 Modules Like macros, modules automate tasks, but they do so by using a built-in 
programming language called Visual Basic or VB. Modules are much more 
powerful and complex than macros.  
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Understand the Screen 

There is a lot going on with the Access program screen, so this lesson will help you become more familiar 
with it. Review the labeled items in the images below, then refer to the tables to see what everything does. 

 

 
Title Bar: Displays the name of the current 
file.  

Help/Display Options: Here you can 
change how much of the ribbon is 
displayed; minimize, maximize or restore 
the screen; or close Access altogether. 

 
Quick Access Toolbar: This is a fast way to 
access the most used features.  

The Ribbon: This is where you’ll find all the 
options you need to make a database. The 
options are grouped into tabs. 
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File tab: This is where you'll find basic file 
management commands, such as New, 
Open, Save, Close, and program options. 

 
Access Object: The Access Object is where 
you can view the content of the open or 
selected database object. 

 
Microsoft Account User Info: When you 
log in with your Microsoft account, your 
name and picture appear here. 

 
View buttons: Use one of the view buttons 
to quickly switch between the different 
views. 
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Scroll bar: Use the scroll bar to view 
different parts of the database object.  

Navigation Pane: The Navigation Pane is 
where you can see and open your database 
objects, such as tables, queries, forms, and 
reports. 

 
Status bar: The Status bar displays 
messages and feedback.  

Object tab: A tab appears for each open 
database object. Click a tab to view and 
work with that object. EVALU
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Open and Save a Database 

To make changes to an existing database, you’ll first need to open it. 

Open a Database 

Click the File tab. 

Click Open. The databases 
you’ve recently opened show 
up here. 

Select the location where the 
file is saved. 

• If you’re signed into your 
Microsoft account, you can 
open files directly from 
OneDrive. 

• Or click Computer to open a 
database that is saved 
locally to your computer. 

Click Browse. 

Navigate to where your file is 
saved and select the file you 
want to open. 

Click Open. 

The database opens. 
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Save a Database 

Now that an edit has been made, let's save the database. 

Click the File tab. 

Click Save As. 

If you want to save the file in 
the same location, just click 
Save. 

Select the location where you 
want to save the file. 

Click Save. 

The file is saved. 
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Work with Database Objects 

Use the Navigation Pane 

Think of the Navigation Pane as the mission control center for an Access database. You use the Navigation 
Pane to open and manage the different types of objects in your database. 

Click the arrow button at the 
top of the Navigation Pane to 
select the type of object(s) you 
want to display. 

The Navigation Pane can 
display different types of 
Access objects. You can change 
the view settings to view all 
the database objects in this 
database. 

Select Object Type and make 
sure there’s a check mark next 
to All Access Objects. 

A menu displays, listing the different 
types of database objects you can 
display. 

Open a Database Object 

Double-click an object in the 
Navigation Pane. 

The Navigation Pane contains buttons 
for each type of database object. 
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Switch Object Tabs 

If you have multiple objects open, you can use the tabs to switch between objects. 

Click the tab for the object you 
want to display. 

The object appears on the screen as a 
tabbed item. 

As you open additional objects, they 
stack on top of each other in the same 
window. To bring a different object to 
the top, where it’s visible, click its tab. 

 
 
 
 
 
 
 

Modify a Database Object in Design View 

Click the View button list 
arrow. 

Select Design View. 

Tip: You can also modify a database 
object in Design view by right-clicking 
the object’s tab and selecting Design 
View from the contextual menu. 
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Close a Database Object 

Click the object’s Close button 
in the upper-right corner of the 
window. 

The object closes. Remember, closing 
an object is different than closing the 
entire database. 

 

 

 

 

 

 

Rename a Database Object 

In the Navigation Pane, right-
click the object that you want 
to rename. 

Select Rename from the 
contextual menu.  

Type a new name and press 
Enter. 

The object is renamed. 
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Delete a Database Object 

Select the object you want to 
delete in the Navigation Pane. 

Press the Delete key. 

Click Yes to Confirm the 
deletion. 

The object is deleted. 

EVALU
ATIO

N 

ONLY



 © 2025 CustomGuide, Inc. 19 

Tour of Tables 

Tables are the heart and soul of any database. They’re where a database stores all its information. All the 
other database objects are merely tools to analyze and manipulate the information stored in tables. 

Open a Table 

Double-click the table you 
want to open in the Navigation 
Pane. 

The table opens as a tab in the 
window. 

Of course, before you can open a table, 
someone will need to have already 
created the table, or else you’ll need to 
be using a database template that 
already has tables created for you. 
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Parts of a Table 

Let’s take a closer look at the current table and identify its different components. 

 
 

 
Fields: Tables are made up of groups of fields. A field is a specific type of information, such as a 
person’s last name, address, or phone number. 

 
Records: Together, the related fields for each individual person, place, or thing make up a single 
record. 

 
Datasheet: Table information is displayed, entered, and modified in a datasheet. A datasheet is a 
grid that contains all the records in a table. 

 
Record selector: The record selector shows indication of the record that you are currently 
working on. 

 
Record Navigation bar: You use the Record Navigation bar buttons to move through the records 
in a table. 

 
Scroll bars: Tables usually contain too much information to display on the screen at once, so 
you’ll have to use the scroll bars to see all of it. 
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Next, look at the record navigation buttons near the bottom of the screen, as shown in the table below. The 

record navigation buttons on the Record Navigation bar display the number of records in the current 

database and allow you to move between these records. 

Table Navigation Using the Record Navigation Bar 

 

Go To Navigation Buttons Keyboard Mouse 

Next record Click the  Next record 
navigation button. 

Press the <↓> arrow 
key. 

Click the record you want 
to select (if displayed). 

Previous record Click the  Previous 
record navigation button. 

Press the <↑> arrow 
key. 

Click the record you want 
to select (if displayed). 

First record in a table Click the  First record 
navigation button. 

Press <Ctrl> + <Home> 
(when not editing 
record). 

N/A 

Last record in a table Click the  Last record 
navigation button. 

Press <Ctrl> + <End> 
(when not editing 
record). 

N/A 

New blank record Click the  New (blank) 
record navigation button. 

N/A Click in the (New) row at 
the end of the table. 

Search for records 
using keywords 

Type a keyword in the 

 box next to 
the navigation buttons. 

N/A N/A 
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Tour of Queries 

A query asks a question about the information in one or more tables and then retrieves the results. 

For example, if you wanted to know which employees had worked for the company for more than five years, 
you could create a query to examine the contents of the Hire Date field to find all the records in which the 
hire date is more than five years old. Access would retrieve the information that meets your criteria and 
display it in a datasheet. 

Open a Query 

Double-click the query you 
want to open in the Navigation 
Pane. 

Notice that the query doesn’t look any 
different than a table. Information is 
displayed in a datasheet, and you can 
even edit records in some queries. But, 
the information in a query isn’t a 
duplication of the data in a table—it’s 
just another way of looking at it. 
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Display a Query in Design View 

In Design View, you can see a query’s underlying tables, which fields are included in the query, and the 
criteria used to specify which records to display. 

Click the View button on the 
ribbon. 

In Design View, you can see a query’s 
underlying tables, which fields are 
included in the query, and the criteria 
used to specify which records to 
display. 

Tip: You can also display a query in 
Design View by right-clicking the query 
object in the Navigation Pane and 
selecting Design View. Or, click the 
Design View button in the Status bar. 

 

 

Change a Query’s Criteria 

Select the information you 
want to edit in the Criteria row 
and type in your changes. 
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Display a Query in Datasheet View 

Click the View button on the 
ribbon. 

Access runs the query and displays its 
records. 
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Tour of Forms 

Forms make it easy to view and work with the information in tables and queries. Forms can include fill‐in‐
the‐blank fields, check boxes, drop-down lists, buttons, and more. 

There are a few different kinds of forms in Access: 

• Form: A traditional form view. In Layout view, you can edit the form design while also displaying 
data. 

• Split form: Creates a split screen that allows you to view information through a Form view and 
Datasheet view at the same time. You can use the Datasheet view to locate a record and the Form 
view to edit it. 

• Multiple items form: Allows you to view multiple records at a time—unlike a regular form where 
you can only work with one record at a time. It looks much like a datasheet, but allows for more 
customization. 

• Other forms types: You may also come across forms that look like datasheets, or Modal Dialog 
forms that pop out in their own dialog box windows (instead of appearing as tabbed items next to 
the other database objects in the main database window). 

Open a Form 

Double-click the form you want 
to open in the Navigation 
Pane. 

The form opens in the window in Form 
view. 
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Navigate a Form 

Use the record navigation 
buttons near the bottom of the 
screen to move to the first, 
last, next, or previous records. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Add a Record 

Click the New Record button 
on the Record Navigation bar. 

A blank form appears, ready to 
accept your information. 

Complete the form fields. 

When you’re finished typing 
information into a form, press 
the Tab key to move on to the 
next field. 

When you’ve finished entering 
the record, you can close the 
form. Click the New Record 
button to create another 
record, or use the Record 
Navigation buttons to view 
another record. 

A simple form may contain only fill-in-
the-blank style text fields, but many 
forms are more complex and may 
contain lists, combo boxes, check 
boxes, and sub-forms. 
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Tour of Reports 

Reports present data in a table or query in printed format. Reports can be a simple list of records in a table 
or a complex presentation that includes calculations, graphics, or even charts. 

Although you can directly print tables and queries, they don’t have any format or display options. 

Open a Report 

Double-click the report you 
want to open in the Navigation 
Pane. 

The report appears in Report View. 

 
 
 
 
 
 
 
 
 
 
 
 

Switch to Layout or Design View 

To edit a report’s structure, you need to change to Layout or Design View. 

Click the View button list 
arrow in the Views group on 
the Home tab. 

Select Layout View or Design 
View. 

Most edits can be made in Layout 
View, but complex tasks require Design 
View. 

EVALU
ATIO

N 

ONLY



28 [Your Company Name] 

Help 

When you don’t know how to do something in Access, look up your question in the Access Help files. The 
Access Help files can answer your questions, offer tips, and provide help for all of Access’s features. 

Click the Microsoft Access 
Help button on the ribbon. 

The Access Help window 
appears. 

Select a topic or click in the 
Search box. 

A list of help topics appears. 

Type a topic and click the 
Search icon. 

Click the topic that best 
answers your question. 

Information regarding the 
selected topic displays. 
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Select a specific topic. 

This way, you jump straight to the 
topic you really need. 

Shortcut: You can also open the Help 
dialog box by pressing F1. 
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Close and Exit Access 

When you’re finished using a database, you should close it. When you close a database, however, the Access 
program doesn’t stop running. To stop using Access completely, you need to exit the program. 

Close a Database 

Click the File tab. 

Select Close. 

The database closes. 
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Exit Access 

Click the Close button on the 
title bar. 

The Access program closes. 

If prompted to save changes before 
exiting, click Yes. 

Clicking the Close button on the title 
bar also closes any open databases. 
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